
Почтовый клиент с поэтическим на-

званием Sylpheed уже обрел популяр-

ность в среде пользователей Linux. Его

полюбили за простой, но в то же время

стильный и функциональный интер-

фейс, широкие возможности и ста-

бильную работу. Вдохновленный этим

успехом разработчик, японский про-

граммист Хируки Ямамото, создал вер-

сию и для Windows. В итоге получилась

добротная почтовая программа, со-

зданная с истинным японским трудо-

любием и скрупулезностью, не уступа-

ющая многим коммерческим аналогам.

Sylpheed имеет многоязычный интер-

фейс, в том числе и русский, понимает

множество символьных кодировок, на-

пример KOI8-R. Справка в программе

пока недоступна, хотя в меню и имеют-

ся ссылки как на онлайновое руковод-

ство, так и на локальное. Можно отме-

тить и одну особенность: при создании

письма отсутствуют функции редакти-

рования, которые мы привыкли видеть

в других почтовых программах привя-

занными к правой кнопке мыши. В ка-

честве альтернативы при редактирова-

нии письма предлагается использовать

Блокнот или другой редактор, установ-

ленный по умолчанию. Но многие ин-

струменты, такие как адресная книга с

возможностью импорта и экспорта, си-

стема фильтров входящих сообщений,

сборщик адресов, реализованы  вполне

достойно.   
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Японский
почтальон

Sylpheed 

Hiroyuki Yamamoto 

http://claws-w32.

sourceforge.net

freeware

Windows, Linux

Многие пользователи Linux хорошо

знают и с успехом используют web-бра-

узер Galeon, входящий в состав графи-

ческой оболочки GNOME. Недавно у

него появился аналог, работающий в

Windows. Он называется K-Meleon, со-

здан на основе движка Gesko (на кото-

ром также работают Netscape и Mozilla)

и распространяется по лицензии GNU

GPL. Хамелеон (это симпатичное жи-

вотное встречает посетителей домаш-

ней страницы проекта), несмотря на

небольшой размер, вполне современ-

ное многофункциональное средство

передвижения по Интернету. Браузером

поддерживаются все современные web-

стандарты, множество языков и коди-

ровок, а его скорость не уступает изве-

стным и именитым. K-Meleon позволя-

ет открывать web-страницы в виде вкла-

док в одном окне, импортирует заклад-

ки из популярных браузеров (Microsoft

Internet Explorer, Netscape, Mozilla и

Opera), причем для каждого из них име-

ется отдельный пункт в главном меню,

логины и пароли он сохраняет с помо-

щью специального менеджера и т. д.

Для облегчения повседневных рутин-

ных операций любой пользователь, да-

же не обладающий глубокими знания-

ми в области программирования, может

создавать макросы. Существует также

большое количество скинов, благодаря

которым внешний вид программы ни-

когда не надоест пользователю.   
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K-Meleon

J. Doozan, B. Harris, M. Liffiton

http://kmeleon.

sourceforge.net

freeware 

Windows

Наш ответ
Галеону
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Из всех вредоносных программ самые

опасные — троянские, хотя они в отли-

чие от классических вирусов информа-

цию на диске обычно не уничтожают, а

лишь стремятся с помощью своей сер-

верной части, установленной на ком-

пьютере жертвы, открыть доступ зло-

умышленнику, у которого, соответст-

венно, установлена клиентская часть, к

тем или иным конфиденциальным дан-

ным. 

Опасность их заключается и в умении

тщательно скрывать свое присутствие.

Поэтому желательно использовать на-

ряду с обычными антивирусами специ-

альные антитроянские утилиты. Напри-

мер, Trojan First Aid Kit.

Эта утилита позволяет просканировать

на предмет серверов троянцев не только

локальный компьютер («Local -> Detect

and remove Trojans»), но и удаленный

(«Remote -> Trojanscanner»). 

Отслеживать же все соединения вашего

компьютера можно с помощью встроен-

ной проверки портов («Local -> Port

Check»). Программа позволяет также

просматривать запущенные процессы

(«Local -> What is currently running?») и в

случае необходимости снимать их од-

ним кликом. То же самое можно проде-

лать с окнами («Show all windows») и с

автозагружаемыми программами («What

is autostarted?»). Для важнейших файлов

можно задать режим CRC-контроля

(«Local -> CRC File Protection»).   
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Trojan Fi rst  Aid  Kit  

SnakeBite

www.kryptocrew.de/

snakebite

freeware

Windows

Антитроянская
операция



Дружелюбный графический интерфейс

современных операционных систем, со-

гласитесь, не был бы столь удобным для

пользователей, если бы в свое время не

была придумана такая замечательная

штука, как компьютерная мышь. Об

этом вспоминаешь каждый раз, когда

очередной «хвостатый» манипулятор

выходит из строя. Увы, но при всех сво-

их достоинствах компьютерные мыши

довольно хрупкие создания. И ломают-

ся они по закону подлости в самый не-

подходящий момент, когда нужно, на-

пример, создать, сохранить или распе-

чатать важный документ.

В таких случаях может выручить про-

грамма эмуляции Mousemu. При на-

жатии NumLock она превращает циф-

ровую клавиатуру в некое подобие

компьютерной мыши, причем не про-

стой, а с поддержкой скроллинга. Кла-

виша с цифрой 3 обеспечивает воз-

можность плавной прокрутки откры-

того окна. «Единица» призвана заме-

нить левую кнопку, а «двойка» правую.

«Четверка», «пятерка», «шестерка» и

«восьмерка» отвечают за перемещение

курсора соответственно вверх, влево,

вниз, вправо. 

Конечно,  с виртуальной мышью много

не наработаешь. Не бесспорен, на мой

взгляд, и выбор клавиш для замены кно-

пок. Они слишком близко друг от друга

расположены, и поэтому все время за-

бываешь, какая за что отвечает.    
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Mousemu 

RH Designs

www.geocities.com/

matroxfiles

freeware

Windows

Виртуальная
мышь

Чем мощнее и функциональнее от вер-

сии к версии становится Adobe Photo-

shop, тем больше появляется альтерна-

тивных графических редакторов люби-

тельского уровня. Возможностей, на-

пример, Oriens Enhancer GOLD вполне

достаточно для решения практически

любых задач обработки цифровых фо-

тографий в домашних условиях. Этот

редактор позволяет нам на свой вкус

настраивать яркость, контрастность и

цветовую гамму отсканированных или

захваченных с экрана иллюстраций.

Количество же автоматически осуще-

ствляемых в нем операций с цветом

могло бы удовлетворить и профессио-

нала. Самая интересная среди них, на

мой взгляд, стилизация современной

цветной фотографии под старую («Co-

lors -> Old Photo»).

В Oriens Enhancer GOLD встроено мно-

жество полезных фильтров, благодаря

которым вы сможете использовать в

своих фотоработах не только традици-

онные, но и весьма оригинальные спец-

эффекты. Можно, к примеру, превра-

тить фотографию в акварельный рису-

нок («Filters -> Painting»). Или взгля-

нуть на нее через рифленое стекло раз-

ного вида («Effects -> Glass»). С помо-

щью панели Textures Emboss вы сможе-

те придать иллюстрации самые причуд-

ливые текстуры. Если результат вас не

устроит, функция неограниченного от-

ката к вашим услугам.   
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Oriens  Enhanser  GOLD 

Oriens Solution

www.oriens-

solution.com

freeware

Windows
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CSDiff 

ComponentSoftware, Inc.

www.component-

software.com

freeware  

Windows

Все, как известно, познается в сравне-

нии. Мы все время что-то с чем-то со-

поставляем, выявляем сходства и раз-

личия и на этой основе делаем какие-то

выводы. Виртуальный мир не стал ис-

ключением. Чаще всего пользователям

приходится сопоставлять между собой

различные версии одних и тех же ката-

логов и документов. Причем делать это

по старинке, вчитываясь в каждую

строчку. Программа CSDiff может ру-

тинный процесс сопоставления сделать

полностью автоматическим. Пользова-

телю теперь достаточно будет указать

исходную (Base revision) и обновленную

(Compared revision) версии документа

или папки. Программа может и сама

определить более старую из них.

CSDiff корректно поддерживает срав-

нение текстовых файлов, а также

HTML и DOC-документов (если уста-

новлен Microsoft Word). Файл отчета о

различиях каталогов программа позво-

ляет сохранить в HTML и XML-форма-

те. Определять изменения в тексте

CSDiff может на уровне знака, слова

или целой строчки. Все, что было до-

бавлено в новой версии документа, бу-

дет отмечено синим цветом и подчерк-

нуто; все, что было снято, окрашено зе-

леным и зачеркнуто.

CSDiff пригодится многим пользовате-

лям, но для филологов, вынужденных

сравнивать разные редакции текста, она

станет бесценной находкой.   

О пользе
сравнения

Лучший друг
фотолюбителя
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Без архиватора не один серьезный

пользователь обойтись не может. На

мой взгляд, для нормальной работы

большинству вполне достаточно будет

возможностей бесплатных архивато-

ров, многие из которых вплотную при-

близились по качеству к коммерческим

аналогам.

Другие не стремятся состязаться с плат-

ными конкурентами, придерживаясь

принципа: чем проще, тем лучше. Ма-

ленький архиватор Simplyzip относится

к их числу.

Эта программа поддерживает пять фор-

матов при упаковке файлов — ZIP,

CAB, LHA, TAR, TAZ, и восемь при ра-

зархивировании, включая RAR, ACE,

BZ2. Программа позволяет тестировать

эти архивы, а поврежденные ZIP еще и

лечить («File -> Zip repair»).

С помощью Simplyzip вы сможете не

только сжать файл, но и при необходи-

мости закодировать его («Option ->

Crypt file») с использованием мощных

криптографических систем (Blowfish,

Rijndael и Twofish). В этом же окне мож-

но его потом расшифровать.

Программа Simplyzip позволяет осуще-

ствлять резервное копирование важ-

нейших файлов на дискеты («File ->

Backup to Disc») с последующим их вос-

становлением. Еще одна оригинальная

функция архиватора — способность

конвертирования двадцати различных

форматов архивов в один из  поддержи-

ваемых при упаковке.   

êÄáêÄÅéíóàä

ëÄâí êÄáêÄÅéíóàäÄ

ìëãéÇàü êÄëèêéëíêÄçÖçàü

éèÖêÄñàéççÄü ëàëíÖåÄ

Simplyzip  

Dirk Paehl

www.dpaehl.de

freeware

Windows

Невозможно представить себе совре-

менного делового человека без визит-

ной карточки. Не все из нас, однако,

могут (или хотят) заказывать изготовле-

ние визиток на полиграфическом пред-

приятии. Многие предпочли бы создать

их самостоятельно на своем домашнем

компьютере. Тем более что каких-то

особых навыков и умений это не требу-

ет, да и современные принтеры на плот-

ной бумаге сделают их не хуже иных пе-

чатных станков.

Проблема заключается лишь в том, что

хорошие «карточные» программы

слишком дороги и не всегда рассчитаны

на русскоязычного пользователя. Ис-

ключение составляет разве что отечест-

венная программа «Визитка». Она рас-

пространяется совершенно бесплатно,

позволяя, тем не менее, создавать кар-

точки на довольно высоком уровне. 

В дистрибутив включено десять стан-

дартных шаблонов, на основе которых

любой пользователь сможет создать для

себя или своих знакомых визитку бук-

вально за пару минут. Для этого доста-

точно ввести в соответствующих полях

все необходимые сведения: место рабо-

ты, должность, ФИО, телефон и т. п.

Для выравнивания строчек разработчи-

ки рекомендуют пользоваться пробе-

лом. Простую заготовку можно укра-

сить эмблемой.

Эскиз возможно сохранить в архиве или

распечатать на откалиброванном в «Ви-

зитке» лазерном принтере.   
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«Визитка»

«É‡ÙËÍ‡-å»

www.vizit-ka.ru

freeware

Windows

Конвертер
архивов 

Визитка
своими руками
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QCad

RibbonSoft

www.ribbonsoft.com

freeware

Windows, Linux

Бесплатный
CAD 

Системы автоматизированного проек-

тирования (CAD) до недавнего време-

ни практически не были отмечены в

категории бесплатного программного

обеспечения. Тем более интересна

OpenSource-разработка под названием

QCad, существующая как для Linux, так

и для Windows. Это довольно простая в

использовании, имеющая многоязыч-

ный (в том числе и русский) интерфейс

2D-программа для разработки черте-

жей, конечно, не заменит полностью

тяжеловесный AutoCAD последних

версий, но учебные и большинство ин-

женерных потребностей она вполне

способна удовлетворить. Пользовате-

лям предоставляются широкие возмож-

ности по работе с линиями, объектами,

штриховкой, текстом и многим другим.

Также реализована поддержка слоев.

Чтобы не загромождать интерфейс, па-

нель инструментов QCad устроена

очень удобно, хотя и не совсем привыч-

но. На ней расположено всего несколь-

ко кнопок, обозначающих общие раз-

делы черчения. Нажимая на кнопку, от-

вечающую, например, за рисование ли-

ний, пользователь видит уже специаль-

ную панель с разными типами линий и

отрезков. Чтобы вернуться к общей па-

нели, достаточно лишь щелкнуть пра-

вой кнопкой мыши по любой кнопке. 

В качестве основного рабочего формата

программа использует DXF, но она так-

же может экспортировать и файлы с

расширением EPS.   
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KoEdit

ëÂ„ÂÈ ãÛÌ„Û

http://ournet.md/~KoEdit

freeware

Windows

Рано или поздно программисты сталки-

ваются с проблемой редактирования

исходных текстов программ, кода web-

страниц, совмещающих в себе синтак-

сис разных языков программирования,

и т. д. Данную проблему призвана ре-

шить рассматриваемая нами утилита

под названием KoEdit. И в этом сложно

сомневаться. В ней имеется подсветка

синтаксиса следующих языков про-

граммирования: Pascal, C/C++, Assem-

bler, Basic, PHP, Perl, Java, Java Script, а

также CSS и HTML и поддержка трех

основных кодировок — WIN-1251,

KOI8-R и DOS-866. Имеется в наличии

и система поиска для программистов,

потерявших нить алгоритма в лабирин-

те исходного кода. А многоуровневая

система откатов и повторов позволит на

минуту вернуться в прошлое и испра-

вить досадную ошибку. Редактируемый

текст можно экспортировать в форматы

HTML и RTF с сохранением подсветки.

Хотите ассоциировать файлы опреде-

ленного расширения с этой програм-

мой — нет вопросов, вам претит огра-

ничение блокнота на размер загружае-

мых файлов — здесь эта проблема ре-

шена.

И самое главное, что придется по душе

любому программисту: KoEdit — про-

ект с открытым кодом, поэтому, как за-

веряет разработчик, любой может вне-

сти изменения в программу или напи-

сать собственный редактор, используя

исходники KoEdit.   

Для начала просто укажем список ме-

диаформатов, которые поддерживает

GermaniXEncoder: MP3, MP2, Ogg Vor-

bis, VOX, WMA, GSM, DSP, ADPCM,

G721, G723, G726, MPC, MP+, AVI,

MPEG, RM и WMV. Забавно то, что

поддерживаются даже те форматы, о

которых я, как, впрочем, многие из вас,

и не слышал. Причем поддержка осу-

ществляется почти полная, то есть в

этом формате может оказаться как вхо-

дящий файл, так и исходящий. Удивля-

ет тот факт, что можно вот так запросто

конвертировать исходный файл сразу

(!) в несколько выбранных форматов. С

другой стороны, стоит поблагодарить

разработчиков — ведь это всего лишь

бета-версия, но она уже столь многое

умеет, тогда как финальные продукты

не всегда способны даже на часть этого.

В программе имеется довольно удоб-

ный встроенный плейер, обладающий

минимальным набором функций, тем

не менее умеющий выполнять все необ-

ходимое. Большими электронными зе-

леными цифрами написано, как долго

продолжается медиафайл и сколько из

этого времени остается до конца. Ана-

лизатор спектра в виде двух цветных по-

лосок (по полоске на правый и левый

канал) только подчеркивает весьма

удачный дизайн программы. Само со-

бой разумеется, что ко всем форматам

предусмотрены настройки. К сожале-

нию, формат MP3Pro программой не

поддерживается.   
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Org Panel

Это не просто программа-органайзер, а

целый пакет утилит, основу которого

составляет панель быстрого запуска,

разделенная на два переключаемых

мышкой раздела.

По умолчанию на ней находятся только

ярлыки утилит самой Org Panel, а также

значки «Панель управления», «Мой

компьютер» и «Paint», но при желании к

ним легко добавить иконки любых про-

грамм. Саму панель можно разместить в

любой части экрана.

Первый ее раздел составили «Днев-

ник», «Записная книжка» и «Блокнот». 

В «Дневнике» вы сможете узнать о пра-

здниках, народных приметах, времени

восхода и захода солнца на тот или

иной день, добавив к ним сообщения о

предстоящих делах и событиях в вашей

жизни с возможным звуковым опове-

щением. В «Записной книжке» можно

указать наряду обычными для органай-

зеров сведениями о том или ином чело-

веке (телефон, e-mail) еще и дату его

рождения. Встроенный в Org Panel

блокнот выгодно отличается от систем-

ного поддержкой DOS, кодировок WIN

и KOI, что может оказаться полезным. 

Наверняка пригодятся и утилиты вто-

рого раздела OrgPan: «Хранитель паро-

лей» и «Конвертер», переводящий еди-

ницы измерения из одной системы в

другую.

Больше,
чем органайзер

Блокнот
для программиста

Конвертируем
все и сразу
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